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At installation, you are automatically prompted for your Company Information. To
change this later, click on the View menu and select Preferences. The center tab is
Company Information. A company logo can be included with the company logo box.
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To register this Inspectware software, click Help, and select Registration Info and make a
note of your Serial Numbers. Contact the office at 877-277-8844 to purchase License
Keys. Enter the e-mail address to which the software is licensed and click Internet
Download or manually enter your License Keys for both the Home Inspection Software,



and the HipPocket Handheld Accessory. A popup box will automatically inform you of
the status of your licenses when you click close.
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In the Open Inspection Records window, you can search the existing records by clicking
the Search button , at the right, above the Choose an Inspection Record window.
You can search by Last Name, First Name, Address, City, State, Zip, Phone Number or
Comments.
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Edit Client Information

To edit the client information, click Addresses and select Clients, or in the Open menu,
click the Edit Client button at the lower left. Change the information, and select Save.

Edit Inspector Information

To edit the inspector information, click Addresses and select Inspectors, or in the Open
menu, click on the document button beside the Inspected By line. Select the inspector
you wish to edit from the drop-down menu, Change the information, and select Save.

Edit Referrals Information

To edit the referrals information, click Addresses and select Referrals, or in the Open
menu, click on the document button beside the Referred By line. Select the Referrer you
wish to edit from the drop-down menu, change the information, and select Save.

Edit Company Information

To edit your company information, click Tools, select Preferences and open the Company
Info tab. A company logo can be included by browsing for the logo in the Company
Logo Path box.

Inspection Walkthrough

Create New
To begin an Inspection, open the File menu and select Open Inspection Record,
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Records box. Click on Create New to begin a new Inspection Record.

Record ID

In the box at the upper right corner, enter the record number. This will maintain the
Inspection Records organization.
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Referred by

Use drop down box to select the Referrer, or click on the blank paper button to the right
of the Referred By box, click New, and enter information for the Referrer.
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Inspected by

Use the drop down box to select the Inspector, or click on the blank paper button to the

right of the Inspected By box, click New, and enter information for the Inspector.
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Inspection Report Comment

The time and date were automatically inserted in this field when the new Report was
created. Add any other comments applicable.
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Client info

Enter Client Information including Last Name, First Name, Address, City, State and Zip.
Omitting Client Information can cause the database to become corrupted, or searching to
be impossible. Telephone and Mailing Address/Comments are optional.
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Enter your type of repair estimation, if you wish to include an estimation. The estimator
will either estimate in number of hours required to fix defects, and cost of parts, or as a
min/max estimator to give low and high estimates for what the repairs could cost.
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Save
Click the yellow highlighted Save button.

Save

Open
Your new Report will now be at the top of the list in the Choose an Inspection Record
box. Click on it to select it, and click Open, or simply double click on the file, to open it.
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Complete report, flag for picture or further comment

Include Front View

Click on the PHOTO box in the Front View of Home line. This automatically includes
the system or subsystem in the Report. Click on the Flag to the left of the comment
button, to Flag it to add a photo later.
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Something must be in type description (subsystem types) first then

Inspect the home, and fill out the report. For each system and subsystem, first click on a
type in the type description section. This will automatically include the subsystem in the
report.
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Something must be in opinion

Subsystems are automatically included as a check. If the system is defective in any way,
select the level of defect in the Opinion column.
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Excluding systems and subsystems

To exclude a subsystem, select the N/A Opinion.

If an entire system is not applicable to the Inspection, click on the system header and
click the Make Current Subsystem Not Applicable button.
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System buttons

The system bar at the top, just below the menu bar begins highlighted. Each highlighted
system is incomplete. You can click on a highlighted system to quickly jump to that
system. The system bar buttons gray out when the system is completely inspected.
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When something is marked as a defect, it automatically brings up the
comment window

When a subsystem is marked as defective in the Opinion column, the comment window
opens automatically.

Comment Box

Comment Pool

Specify the issue with the subsystem in the Comment Window either by double clicking
one or more of the Comments in the Comment Pool,



Clamaged or missing covers should be repaired
GFCl on garage would nottrip when tested and should be repaired.
GFClwould not trip when tested and should be repaired.

or by entering your own comments into the Comment box, and by using the Frequently
Used Items Box explained below. If there is a Comment in the Comment Pool for
another subsystem in the same system, or in any other system, click on the System or All,

to show the Frequently Used Comments for the entire System, or for all Systems.
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Sorting Comments

All Comments in the Comment Pool can be sorted with the buttons in the Pool Order
section to the right. To move one particular comment up or down, highlight that
comment, and click the red up or down arrow. To sort the comments alphabetically, click
the ABC button. To permanently save your ordering changes, click the vertical Save

button that appears at the right of the up and down arrows when you have made changes.
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Frequently used items drop box (apartment unit, location, etc)

The Frequently Used Items drop box can be used to add items you often use in multiple
subsystems without adding them to the Comment Pool for each subsystem they are used
in, and without having to browse all comments to find it each time. It can also be used to
refer to certain areas, or to different rooms or units within the same inspection, easily.
Selecting the item from the drop box will automatically add it to the end of the comments
in the Comment Box.
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User Defined Comments

Any comment can be typed into the Comment box. It can be added to the Comment Pool
by clicking the Add to Pool button. Comments can also be removed from the pool by
highlighting them and clicking the Remove button.



Edit Spell Check
Personalized Comments can be typed here.

i~ Comment Pool
% SubSystem _#dd to Poal |
{ S_',_IStEITI f“' é" Femowve

|Damaged ar missing covers should be repaired
GFChwould nottrip when tested and should be repaired.

| GFCl an garage would not trip when tested and should be repairad.

Hot Scan

Selecting Hot Scan keeps you from closing the comments box with the Opinion marked
as Satisfactory if there are certain words generally used to describe defects in the
Comments.

Haot i
4 Scan —

These words can be changed in the Hot Scan Keywords box. Left clicking on the Hot
Scan checkbox will turn off and on the Hot Scan. Right clicking on the Hot Scan
checkbox will bring up the Hot Scan Keywords list.
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Edit comments later by using comment button on right

To change comments later, click on the Comment button in the corresponding row at the
right of the screen. The comment button is dark gray if there is no comment, light gray if
there is a comment, and yellow if there is a picture.
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Flag for Photos and/or Additional Comments

Flag all systems and subsystems requiring photos or additional comments.
. |COMMENT
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Next incomplete system or uninspected subsystem

To proceed to the next incomplete system, click the corresponding highlighted tab in the
system bar.



coveR |_EXTER | GROUM| GUTTE |_For
To find the next uninspected subsystem, click on the Next Uninspected Subsystem
button.
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Go to next flagged subsystem

Once all the systems are completed, click the Go To Next Flagged Subsystem button, to
find systems and subsystems that need further comment, or pictures attached.
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Add pictures to flagged subsystems

To add a picture to a subsystem, click on the Comment button on the right,
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and in the comment screen, click on the Add Photo button.

Photos

Add a Photo
To add a photo to your Inspection Report, click the Comment button, and click the Snap
Y

Shot button.
want to insert.

Click on the folder open button and browse to the photos you
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Select the one you want by clicking on it once. It will appear on the right side of the
Select Image box, and the name will appear in the Image List Editor column in the center.
All Photos included in the Image List Editor will be included in that subsystem. Photos
can be removed by clicking the Delete Selected button. Photos can be reordered by
highlighting their name in the Image List Editor box, and clicking the Up and Down
arrows.
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Highlight photos

To add highlights to a photo, use the Drawing Options in the center of the Select Image
box. To create an arrow, click and drag on the picture.
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To change the color or the line width of the arrow, click the preferences button and select
a new line width or color. Click Ok. To change to a circle or box, click on the
corresponding check box.
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To undo your changes, click the clear arrows button.
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Add multiple photos to one subsystem

Proceed as with adding one photo, but select two photos. The list of included photos can
be found in the center of the box, in the Image List Editor. There is a maximum of five
photos in a subsystem recommended. More photos can be added, but a pop-up box will
warn that this has been exceeded, and these pictures may be cut off on the final reports.
Pictures may also be removed by highlighting their name and clicking the Delete

Selected button.
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Cover Photo/ COVERPAGE

To add a cover photo, add a photo to the System called COVERPAGE. COVERPAGE
must be the exact file name to put the photo on the cover page instead of in the report as a
subsystem. Subsystems can be added to cover page but may result in multiple cover
pages, and are not recommended.
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Spell check

Select the Tools menu, and click Spell Check or press Ctrl+S. This will spell check all
comments in your report.

Preview report

To preview your completed report, or a section of it, select the File menu, select Preview
Screen and your option, or Preview All for the full report. Your report will now be in
PDF format. Press page down to proofread report. If you do not want a PDF created,
this can be changed in the Tools/Preferences menu in Report Preferences.



Save/Print/Burn to CD/e-mail

This PDF report can be saved in RDF format, by selecting File and Save. It can be saved
in PDF format by clicking Export PDF. The PDF file and all photos will be saved in a
folder in the Inspectware directory. The report can be printed either from the PDF
preview screen, or by selecting File and clicking Print Summary, Print Report, or Print
All. The report can also be burned to CD.

Estimator Report

If you have included estimator data in your report, and wish to provide an Estimator
Report click Administrative, select Import/Export and select Export Estimator Report.
This will export a comma separated value estimator report which can be opened in
Microsoft Excel, or similar spreadsheet programs and given to the client with the
inspection.



